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QUESTION 1

You plan to conduct a manual test for an ASP.NET website by using Microsoft Test Manager (MTM). You create a test
plan named Calculate_Margin by using Testing Center in MTM. 

You need to link all the test cases that belong to the Calculate_Margin test plan with new requirements that are stored
as work items in Team Foundation Server 2012. 

What should you do? 

A. In the Links section of the test plan, click Add link to associate the requirements document. 

B. Associate the requirements document with the test plan by name, then add a link by using the area path relevant to
the requirements being tested. 

C. Create the test cases within the test plan by using a Test Suite, then associate the new requirements by adding them
as attachments to the test cases. 

D. Click Add requirements from the Contents menu of the test plan and associate the new requirements. 

Correct Answer: D 

Add an existing requirement to your test plan To add an existing requirement to your test plan 

1.

 Open Microsoft Test Manager. 

2.

 From the Testing Center, click Plan and then click Contents. The Contents pane is displayed. 

3.

 To add a requirement to your test plan, select the location where you want to place it in the test suite hierarchy and
then click Add requirements. The Add existing requirements to this test plan dialog box is displayed. 

4.

 Select any requirements that you want to add to the test plan, and then click Add requirements to this test plan.
Reference: How to: Add Requirements or User Stories to Your Test Plan 

 

QUESTION 2

Your team uses the Microsoft Visual Studio Scrum process template for a project. Your team uses the Area to filter by
Function, with subcategories pertinent to those functions. 

Your stakeholders want to be able to view requirements and quality reports by specific department. 

You need to modify the Test Case Readiness report to add a filter so that the report can be filtered appropriately. 

Which five actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to
the answer area and arrange them in the correct order. 
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Select and Place: Select and Place: 

Correct Answer: 

Note: 

* You can filter the Test Case Readiness report to show only those test cases that are defined for the product areas,
states, and priorities that you specify. The following illustration shows the available filters: 
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By using Report Builder or Report Designer, you can allow users to update reports without granting them read access to
the databases. 

* Example: 

To add a custom filter, example:

1. In Report Dataset Designer, on the View menu, choose C/AL code to open the C/AL Editor. 

2. In the OnPreReport trigger, add the following code: ReportFilters := Customer.GETFILTERS;. Close the C/AL Editor. 

3. In Report Dataset Designer, right-click the Cust. Ledger Entry DataItem, and then choose New to create a new row at
the bottom of the Customer DataItem. 

4. In the new row, in the Data Source field, enter the following code: Customer.TABLECAPTION+\\':\\' + ReportFilters. In
the Name field, enterCust_ReportFilter. 

5. Repeat step 3 to create a new row at the bottom of the Customer DataItem. 

6. (step 4) In the new empty row, in the Data Source field, choose the AssistEdit button to open the C/AL Symbol Menu
window. In the leftmost window, selectReportFilters, and then choose the OK button. In the Name field, enter
ReportFilters. 

7. On the File menu, choose Save to save the report. 

8. In the Save window, make sure that Compile is selected, and then choose the OK button. 

9. On the View menu, choose Layout to open the RDLC layout in Microsoft Visual Studio. 

10. In the body section of the layout, select the List control and move the report down to create space at the top of the
report. 

11. On View menu, choose Report Data to display the Report Data pane. 

12. (step 5) On the DataSource node, under DataSet_Result, drag the Cust_ ReportFilter item to the space you that you
created at the top of the body of the Report Designer (step 5). 

Reference: Walkthrough: Adding Company Information, Custom Filters, and Formatting to a Report 

 

QUESTION 3

You plan to conduct a manual test for an ASP.NET website by using Microsoft Test Manager (MTM). You create a test
plan named Release 1.0 by using Testing Center in MTM. You need to configure the Release 1.0 test plan so that all
the test cases in the test plan will run against the following platforms: 

Microsoft Windows 7 and Windows Internet Explorer 8 
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Microsoft Windows Server 2008 and Windows Internet Explorer 8 What should you do? 

A. 

Create new test environments with the specified configuration settings and associate the newly created environment to
the test plan by changing the automated test environment settings. 

B. 

Create new test configurations with the specified configuration settings and associate the newly created configuration to
the test plan by changing the configuration settings. 

C. 

Create new test environments with the specified configuration settings and associate the newly created environment to
the test plan by changing the manual test environment settings. 

D. 

Create new test environments with the specified configuration settings and associate the newly created environment to
the test plan by changing both the manual and automated test environment settings. 

Correct Answer: B 

At any time when you are planning what to test, you can add test configurations and set them as the default
configurations for your test plan. When you next add test cases to the test plan, a pairing of each default configuration
with the test case is added to the test plan. When you run the tests from the test plan, these pairings called test points
are shown and each can be run individually. Test results are saved for each test point. 

You can also override the default test configurations for the plan and set different default configurations for a specific
test suite. When test cases are added to these test suites, a pairing of each default configuration for the test suite with
the test case is added to the test plan as shown in the following illustration. 
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Reference: How to: Select Different Test Configurations For a Test Plan or a Test Suite 

 

QUESTION 4

You are using Microsoft Test Manager (MTM) to track bugs that have been found during testing. 

You need to verify a bug by re-running the test case associated with the bug. 

Which actions should you perform? (To answer, move the five appropriate actions from the list of actions to the answer
area and arrange them in the correct order.) 

Select and Place: 

Correct Answer: 

Note: 
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To verify that a bug is fixed 

1. Open Microsoft Test Manager. 

2. To run the test, choose the down-arrow on the center group switcher and then choose Testing Center. 

3. On the center group menu bar, choose Test. 

4. To view the bugs assigned to you, choose Verify Bugs. 

The Verify Bugs view is displayed. It lists all the bugs that are currently assigned to you. 

5. (Optional) To view the bugs that you created, choose Created by me. 

6. Select the bug that you want to verify, and then choose Verify. 

Finally choose Start test to rerun this test. 

Reference: How to: Verify a Bug is Fixed Using Microsoft Test Manager 
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QUESTION 5

Your team uses Microsoft Test Manager to manage test cases. You are creating test plans for your team to use. 

You need to update your test plan properties before your team creates test suites and test cases. 

Which two test plan properties should you set? Each correct answer presents part of the solution. 

A. Expected Results 

B. Assigned Tester 

C. Area Path 

D. Owner 

Correct Answer: CD 

 

Incorrect: 

Expected Results and Assigned Tester are set for the Test Suite, not the Test Plan. 

Reference: Creating and Defining a Test Plan 

 

QUESTION 6

You are using Microsoft Test Manager (MTM). 

Your company no longer supports a particular configuration for the application under test. 
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You need to ensure that the test configuration is unavailable as an option in a test plan. 

Which state should you assign to the test configuration? 

A. Closed 

B. Inactive 

C. Disabled 

D. Idle 

Correct Answer: B 

When you have completed the tests in a test plan, set its state to Inactive. This prevents more tests from being run in
this plan, but still allows the results of existing runs to be viewed. When the results are no longer required you can
delete the test plan. 

 

QUESTION 7

You are a managing test cases by using Microsoft Test Manager (MTM). 

You create a new configuration. 

You need to select the new configuration for all test cases in a test suite. 

What are two possible ways to achieve this goal? (Each correct answer presents a complete solution. Choose two.) 

A. Select the new configuration as the default configuration for the test suite. 

B. Select the test suite and use Configurations to select the new configuration for the test suite. 

C. Select all of the test cases in the test suite and use Configurations to select the new configuration for the selected
tests. 

D. Select the test suite and use Select test configurations for all tests to select the new configuration. 

Correct Answer: AC 

C: In the test plan, you can set the configurations to be used for one or more test cases: 
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A: Set the default configurations for your test plan 

Instead of setting the configurations for each test case separately, set the default configurations for in the properties of
your test plan. The defaults apply both to new test cases and to test cases that you copy from a previous plan. 

To set the defaults, choose Testing Center, Plan, Contents. Select the test plan at the root of the tree. Then choose the
drop-down selection at Default configurations. 

Reference: Test Configurations - specifying test platforms 

 

QUESTION 8

Your team is using Microsoft Test Manager (MTM). 
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You have a manual test case for a web page on which the user is required to enter information into several text fields.
The test takes a long time to run. According to previous test results data, there are problems with testers entering data
in 

the wrong fields. 

You need to use MTM to eliminate the repeatability issues with the least amount of effort. 

What should you do? 

A. Break the test up into several shorter test cases to isolate the steps that have repeatability problems. 

B. Create an action recording and fast forward to repeat the test steps that have repeatability problems. 

C. Convert the test case to an automated test. 

D. Change the order of the test steps so the least repeatable steps are run first. 

Correct Answer: B 

After you create an action recording, you can play it back while you run a test that contains the recording. This helps in
circumstances where you might have to run the test multiple times because the action recording automatically plays
back the steps. Alternatively, you can fast forward through the test steps until you reach the correct test step to verify a
bug. 

Reference: How to: Play Back an Action Recording 

 

QUESTION 9

You are using Microsoft Test Manager (MTM). You are using the Microsoft Visual Studio Scrum 1.0 process template. 

You need to generate a list of product backlog items (PBI) in MTM that have zero test cases. 

What should you do? 

A. Open each PBI and visually inspect the work item links. 

B. Create a requirements-based test suite. 

C. Click Requirements coverage in the Results view. 

D. Create a Direct Links query. 

Correct Answer: D 

Direct links query: Returns work items and any work items that are linked to these items 

 

QUESTION 10

You are using Microsoft Test Manager (MTM). You are using the Microsoft Visual Studio Scrum 1.0 process template. 

Your client has added new capabilities to a product in development, which necessitates a major change to existing test
cases. The product owner has created a new product backlog item (PBI) and has provided you a link to a document
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that 

explains these new requirements. 

You need to provide easy access to the requirements document from the test cases. 

Which two actions should you perform? (Each correct answer presents part of the solution. Choose two.) 

A. From the Test Suite window, add the requirement document by using Add Requirements. 

B. From the Links tab, link the requirements document to the PBI. 

C. From the Test Plan Manager, add a link to the PBI. 

D. For each test case, use the Tested Backlog Items tab to add a link to the PBI. 

Correct Answer: AD 

A: Add requirements to a test plan 

Typically, you create a test plan for each iteration and area of your team project. Near the start of the iteration, you add
the product backlog items, user stories or requirements of that iteration to the test plan. 

1.

 In Microsoft Test Manager, choose Testing Center, Plan, Contents. 

2.

 Choose Add Requirements. 

3.

 In Add existing requirements, edit the query to find the requirements you want. 

For example, you might add a clause to select the current Iteration Path. Or, you might choose requirements that are
not already linked to test cases. 

4.

 Choose Run to run the query and display requirements. 

5.

 Select the requirements you want to add. 
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A: 

D: The Tested Backlog Items tab lists all the PBIs and bugs in a test case. By linking PBIs and bugs to test cases, the
team can track the progress made in testing each item. 

Reference: Scrum process template work item types and workflow Creating Tests for Product Backlog Items, User
Stories, or Requirements 

 

QUESTION 11
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You are using Microsoft Test Manager (MTM). 

You are developing a test that requires a test step to verify a result against a known value. You plan to insert a new step
to accomplish this task. 

You need to make the new step a validation step. 

What should you do? 

A. Type the expected value into the Expected Result column of the new test step. 

B. Type the expected value into the Action column of the new test step. 

C. Add the expected result value into the Parameter Values pane. 

D. Add a parameter to the Action column of the new test step. 

Correct Answer: A 

When you create manual test cases, you can add the action and expected result for each test step, as shown in the
following illustration. When you run this test, you will be able to mark each test step as either passed or failed. 

Reference: Quick Start Guide for Manual Testing using Microsoft Test Manager 
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QUESTION 12

You are using Microsoft Test Manager (MTM) to manually test for an ASP.NET website. You have previously created a
test plan named QA Release 1.0 that contains 115 test cases, and you are now planning the testing for Release 2.0.
The QA Release 2.0 test plan must meet the following requirements: 

All the test cases in QA Release 1.0 should be available in QA Release 2.0. 

Testers should be able to change, add, or remove test cases from either the QA Release 1.0 test plan or the QA
Release 2.0 test plan as required, without affecting the other test plan. 

Shared steps and test configuration from the QA Release 1.0 test plan need to be reflected in QA Release 2.0 test
plan. 

You need to facilitate simultaneous testing of the website by creating the QA Release 2.0 test plan according to the
stated requirements. 

What should you do? 

A. Copy the root test suite from the QA Release 1.0 test plan into the QA Release 2.0 test plan. 

B. Clone the root test suite from the QA Release 1.0 test plan into the QA Release 2.0 test plan. 

C. Copy all the test cases from the QA Release 1.0 test plan into the QA Release 2.0 test plan by using the Create copy
option in Test Case Manager. 

D. Export all the test cases from the QA Release 1.0 test plan into Excel, then import them into the QA Release 2.0 test
plan. 

Correct Answer: B 

Cloning test suites by using tcm.exe (copy by value or deep copy) creates new test cases in the destination test plan.
These new test cases are copies of the test cases in your source test plan. After the copy, you can edit the test cases in
either plan without affecting the other. Cloning test suites is useful when you want to work on two differing releases
simultaneously. The source and target suites must be in the same team project collection. 

Reference: Copying and Cloning Test Suites and Test Cases 
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